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As I mentioned last month, I have been spending
virtually every free moment I can trying to complete
my remodeling project. When I go to sleep at night,
my head is filled with measurements. NOTHING is
square, straight or true in this older house I make my
home. Every single piece has to be custom cut and
fit. There are funky angles at every turn. As a result,
putting up the walls is taking at least three times as
long to do than it should.

No matter how many times I measure, nothing
comes out fitting as closely as I would like. All I can
say is that I’m thankful for trim to cover up the gaps
between the ceiling and walls. Aside from the
prohibitively time consuming and arduous task of
making a paper template for each and every piece,
there is no easy or practical way to account for the
small variances that make precise cuts virtually
impossible.

To complicate matters and slow things down even
more, my son is terrified of any power saws. So, dad
has taken to making as many cuts as possible using
hand saws. It slows things down a bit, but it’s better
than him standing there bawling, scared to death
from the power saws. I can’t say I blame him, either.
The power saws are loud, and it isn’t a very pleasant
sound. But he absolutely LOVES being upstairs,
helping … well, helping as much as a two year old
can help.

A little closer to PCLinuxOS, forum user The Chief
inquired about a utility to automatically switch
between the touchpad and mouse, depending on
whether a mouse was plugged in or not. He had
settled on Touchpad Toggle, a program I had written
a few years back and that is in the PCLinuxOS
repository. Although it didn’t do what he wanted the
way he wanted, he settled on it anyways. So, I
revisited the Touchpad Toggle program to see if I
could modify it to automatically switch between the
touchpad and mouse. Working on it late at night
after completing my work on the upstairs, I did
manage to rewrite it so that it does exactly what The
Chief wanted. You can see the resulting new script
here and here. I’ve named it Touchpad Toggle Auto.
I’ve since further modified it (second link) so that a
desktop notification appears whenever the switch
between the mouse and touchpad is made,
depending on whether or not a mouse is plugged in.

When a mouse is plugged in, the touchpad is
disabled. If no mouse is plugged in, the touchpad is
enabled.

In other business, Texstar is hard at work on KDE 5,
which will eventually replace the popular KDE 4. It
will join the other releases of Mate, Xfce, LXDE, and
e17/18/19/20 (the latter is so confusing).

With the “retiring” of the 32 bit version of
PCLinuxOS, I (and other users) need to get busy
and replace the 32 bit installations (which is all of
them here) with the 64 bit version of PCLinuxOS. I’m
definitely going to be saddened to have to retire
perfectly good, working computers when I am finally
forced to make the switch. PCLinuxOS is the only
Linux and the only OS in use in this house, save a
few VirtualBox installations here and there (WinXP,
Win2K, and an old version of Linux Mint).

Until next month, I bid you peace, happiness,
serenity and prosperity.

Looking for an old article?
Can't find what you want? Try the

PCLinuxOS Magazine's
searchable index!

Welcome From The Chief Editor

http://pclosmag.com/htdig
http://www.opensource.org/
http://www.pclinuxos.com/forum/index.php/topic,137250.msg1171634.html#msg1171634
http://www.pclinuxos.com/forum/index.php/topic,137250.msg1172048.html#msg1172048
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by Paul Arnote (parnote)

Back in November 2014, YouCanToo detailed how to
view Netflix on PCLinuxOS. Then, it involved having
to install the Google Chrome browser, installing NSS
(Network Security Software) libraries, entering the
command just so, standing on your head, holding
your mouth just right, while spinning around on your
head with perfect balance four times, without
messing up your hair (if you have any).

OK … maybe it wasn’t THAT difficult, but compared
to just viewing a regular web page, or even just
viewing YouTube, it seemed like it. The problem
comes from Netflix using DRM (Digital Rights
Management) when streaming its content.
Regardless of how you feel about DRM, it is here to
stay, and we all have to deal with it. Netflix says it
has to use it to protect the interests of the copyright
owners, who are ever fearful that someone might
possibly maybe download their content without the
copyright owner gaining any financial compensation.
But then, this article isn’t about discussing the
pluses and minuses of the current state of the
copyright environment. This article also isn’t about
discussing the downloading of media content, and
the endless pursuit of greed… er, profit.

Fast-forward 18 months, and things have changed
… for the better. Way better, in fact. Now, all you
have to do is view Netflix in the Google Chrome
browser, just like any other “normal” web page.
However, keep in mind that Netflix ONLY works in
the Google Chrome browser – at this point in time.
Also keep in mind that we’re talking about viewing
Netflix on L-I-N-U-X, particularly PCLinuxOS. Your
Windows installation (if you have one) most likely will
play Netflix in any and all – or at least most – of the
browsers you use there.

The show “Longmire” playing in Meemaw’s Netflix account in Google Chrome on PCLinuxOS.

Netflix On PCLinuxOS: 18 Months Later

http://pclosmag.com/html/Issues/201411/page01.html
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Since Netflix has abandoned – or is in the process of
abandoning – the use of Microsoft’s closed and
haphazard Silverlight plugin, it has embraced
HTML5. The W3C has endorsed and included DRM
into the proposed HTML5 video standard, via EME
(Encrypted Media Extension), which allows DRM-
encrypted content to be streamed via HTML5. This
is what is largely responsible for allowing Linux
users to access Netflix. Couple in the efforts of
various Linux distros working with Netflix, Google
including EME support in the Google Chrome
browser, W3C’s HTML5 video and EME specs, and
Mozilla’s NSS support, and you have a recipe that
now includes Linux users.

So why isn’t Netflix available in Firefox, or any of the
other browsers? Under Windows, it appears to be (I
have to rely on the words of others, since I no longer
use Windows). But under Linux, only the Google
Chrome browser has the magical mix of EME and
NSS support.

Mozilla, the company who produces Firefox, is a
strong open source software advocate. In fact, they
are also the creators of the NSS libraries that are
necessary to view Netflix. As such, Mozilla views the
included support for DRM in the HTML5 video
standards via EME a setback for the open source
community. Even though they lobbied hard against
including DRM in the HTML5 video standards, the
W3C proceeded with its inclusion.

Despite fighting the good fight for the entire open
source community, Mozilla lost. In a way, we all lost.
So now it’s a matter of keeping and attracting users,
so EME support should be forthcoming very soon.
EME support is already included in the Windows
version of Firefox, so it’s only a matter of time before
it makes it to the Linux version.

For the time being, if you want to watch Netflix on
PCLinuxOS, you will need to continue to use the
Google Chrome browser. Fortunately, we can further
simplify gaining access to your Netflix account by
turning Netflix into a desktop application. Yup! We

can give you access to your Netflix account by just
clicking the icon for Netflix on your desktop, thanks
to Google Chrome’s “Add to desktop” feature.

(If you promise to keep a secret, I’ll let you in on one
you might find useful… you can also create a
desktop application for virtually any website you
frequently visit by using Google Chrome’s “Add to
desktop” feature. Just follow these instructions that
follow. Then, you can tailor the desktop link to your
liking by editing the resulting *.desktop file to display
the icon of your choice.)

Meemaw's "main" browse Netflix window.

Netflix On PCLinuxOS: 18 Months Later

http://www.fsf.org
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Click your mouse on the “hamburger” icon in Google
Chrome. Go to “More tools” and select “Add to
desktop…” from the submenu.

Then, click on the “Add” button in the next dialog box
that appears. Take a look at your desktop, and you
should find a new desktop icon. Selecting that icon
will open a Google Chrome window with your
selected site loaded and ready to go.

Summary

I’m reminded of an old American cigarette ad (back
when there were such things) that proclaimed
“you’ve come a long way, baby.” Yes, running Netflix
on Linux has come a long way. We went from being
ignored and forgotten about, to finally being
included. Long gone are the days when users kept a
dual boot computer with Windows, or kept a running
copy of Windows going in VirtualBox, just so they
could watch Netflix. Today, it’s simply not necessary
to do so.

Despite the double edged sword that was created by
W3C’s decision to embrace DRM in the HTML5
video and EME specs, the good side is that it now
allows us Linux users the same access as all of
those other users of the commercial operating
systems.

I may end up being one of those holdouts waiting for
EME support to come to Firefox. The Google
Chrome browser has become very bloated and slow
on all of my computers, except my six core desktop

with 8 GiB of RAM (most every other computer I
have has two or less CPU cores, and none have
more than 4 GiB of RAM). On those “other”
computers, Google Chrome hogs a disproportionate
amount of CPU cycles and RAM. Firefox is much
more responsive on all of my computers, consuming
significantly fewer CPU cycles and significantly less

RAM. Even on my fully capable desktop computer, I
stick with using Firefox. I see no need or reason to
unnecessarily waste CPU cycles or RAM.

Screenshot ShowcaseScreenshot Showcase

Posted by chilly, on April 14, 2016, running KDE.

Netflix On PCLinuxOS: 18 Months Later

http://www.linuxfoundation.org/
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by Paul Arnote (parnote)

There could be many reasons services like Hulu and
Netflix aren’t for you. Some of you might not be able
to afford to subscribe to a monthly service. Others of
you might not want to support a service (or services)
that has (have) a long history of ignoring Linux
users. Still others of you might not want to support
commercial endeavors, propping up the financial
coffers of already wealthy corporations. I’m sure
there are just as many other reasons as there are
users who choose to forgo these subscription
services.

Then, along comes TubiTV. Headquartered in San
Francisco, CA, USA, they offer thousands and
thousands of movies, documentaries and TV shows
to stream over your connected devices and
computers. The selection is always being updated,
with some items being taken away after a while and
new items added all the time. Here’s the BEST thing
about TubiTV: IT’S TOTALLY FREE!

Yes, you will still have to register at TubiTV, but
registration is free. Once registered, you can stream
content to your heart’s content – as much or as little
as you want.

Here’s a little more about TubiTV, from the TubiTV
“About Us” page:

Who we are

Tubi TV is all about delivering the best streaming
entertainment experience, with the largest curated
library of movies and TV shows, all for free. We
believe that sometimes, the best things in life ARE
free, especially when it’s awesome entertainment.
Tubi TV has the best mix of popular and iconic
entertainment that can be enjoyed wherever you
want. We have a ton of Not On Netflix content and a
whole bunch of other categories, you really have to
check them out, and we update them weekly. We may
be free, but we’re feeling good that you’ll be
impressed.

Our Team

The Tubi TV cast is full of passionate people who
love entertainment, and entertaining each other. In
between bouts of movie trivia and debates on “what
qualifies as a classic movie”, Team Tubi TV is
working hard to bring the best entertainment to you,
all for free. As long as movies and TV shows are still
being made, our job is never done. And we LOVE it!

The “browse” screen (above) looks an awful lot like
the similarly named page in Netflix. While they may
not necessarily be the most current offerings, I’m
sure that everyone will find something that they’ve
been meaning to watch, but – for one reason or
another – have been putting off and never gotten
around to watching. I’m also certain that many users
will find items they’ve watched before, and wouldn’t
mind watching again.

TubiTV: A Free Streaming Alternative

http://www.commandlinefu.com
http://tubitv.com/
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The category screen (left) should give you a good
idea of the wide variety of categories that TubiTV
offers up for your viewing pleasure.

You can select a video streaming bitrate that works
best with your available bandwidth. I can attest that
even the slower bitrates display well, with little
noticeable loss of quality. Clicking on the “HD” icon
on the video playback bar will allow you to select the
video bitrate to use. The above image was taken
while TubiTV was streaming content to my laptop at
a slightly less than “medium” bitrate, and the image
was still quite good and sharp.

When you’re streaming from TubiTV, you will have to
turn off any ad blocking software. TubiTV simply
refuses to play any movies until and unless such
add-ons are disabled. I use AdBlock Plus. You can
just turn off AdBlock Plus on the TubiTV website,
leaving AdBlock Plus on for the other sites you may
have open in other tabs. Being a free service,
TubiTV is supported by the occasional
advertisement. However, the ads are infrequent and
brief. They are certainly far less frequent and lengthy
as the typical commercial breaks in American TV.

If you’re using Google Chrome as your web browser,
and you happen to posses a ChromeCast, you could
also stream the content from your computer to your
ChromeCast. Then, you can watch your selections
on your TV, rather than your computer monitor. You
can probably also get similar results from other
competing “cast” devices.

Summary

With a fairly decent selection, TubiTV is worth taking
a look at. Without a doubt, the price can’t be beat.
TubiTV may not offer up the most current movies
and TV shows, you really don’t expect such a quality
lineup for free. What do you have to lose (except
some time when you find something to watch)? Who
knows… sometimes the best things in life ARE free.

"Death Wish 2," starring
Charles Bronson (right),
playing in Firefox.

TubiTV: A Free Streaming Alternative
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Windows friends are gonna be impressed
When I show them PCLinuxOS
When I show them PCLinuxOS

Made by Texstar

Watch them as they stand there a gawking
About Linux they all are a talking

To PCLinuxOS they'll be a-flocking
Thanks to Texstar

Watch them as they stand there a gaping
From that Windows they'll wanna be a escaping

Files and folders they'll soon be reshaping
Thanks to Texstar

It boots so fast no need to wait
You won't find anything finer
As a Linux OS it is top rate

Texstar is a wonderful designer

Come to the forum now let's all give a cheer
The mods are treating everyone to a beer

Texstar is the man of the year
We'll never swap

Because PCLinuxOS is the topMP3 OGG

ms_meme's Nook: PCLinuxOS Is The Top

http://pclosmag.com/html/Issues/201605/files/pclinuxosisthetop.mp3
http://pclosmag.com/html/Issues/201605/files/pclinuxosisthetop.ogg
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Available in the following desktops:

KDE LXDE Xfce

Mate

Enlightenment

Screenshot ShowcaseScreenshot Showcase

Posted by daniel, on April 18, 2016, running LXDE.

http://www.linuxquestions.org
http://www.pclinuxos.com
http://chimpbox.us
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In his own words

What is your name/username?
My name is Justin and my username is jlane01.

How old are you?
I am 42 years old.

Are you married, single?
I am divorced, but still live in the same house with
my ex. We're still the best of friends and neither one
of us wanted to give up our house or our pets, and
we couldn't afford our house on our own so we
made it work.

How about Kids, Grandkids?
No kids that I know of yet.

Do you have pets, what is your favorite?
We are bird lovers, we have chickens, turkeys,
peafowl, pigeons, doves, a couple of ducks, a
couple of pheasants, and a guinea fowl.

Are you retired, still working and if working, what
do you do?
I currently work in the insurance industry as a
commercial underwriter. Not very exciting, but it
does pay the bills. One of my jobs was also being
my office's IT person. I've learned a lot over the
years from breaking my system and from being my
office's IT person have learned enough to get myself
into trouble.

Where abouts do you call home? What is it like?
IE: weather, scenery
I've lived in the northeast my whole life. Born in
Massachusetts, lived in Sullivan County NY for many
years, currently live in Pennsylvania. Pennsylvania
seems to be the perfect blend of cold winters but not
too cold and warm summers, but not too hot. We still
get all four seasons, even if some of them are a
week or two in length. My favorite seasons are
spring and fall.

Where did you go to school and what is your
education level?
I've been up and down the east coast during my
college education. I started at Unity College in Maine
and ended up at West Virginia State College in West
Virginia. I ended up with a BA in English Literature.

What kind of things you like doing? hobbies,
travel, fishing, camping?
I used to camp a lot in my younger days, but have
gotten away from that as I got older. Now I prefer a
comfy bed to sleep in. I like to read a lot of books
and also spend time taking care of my birds. I
started writing poetry back in college and have
started writing again after taking a break from it for a
few years. I also enjoy tinkering around with
computers and Linux distros. I used to be a distro
hopper and have played around with most of the
major distros. I also enjoy making both wine and
beer in my spare time. I think homemade is better
than store bought, as you know exactly what you put
into it. It does take practice, but practice makes
perfect.

Why and when did you start using Linux?
I started using Linux back around 2006 when an IT
friend of mine suggested that I try out Puppy Linux
when a computer died and I needed to get files off of
it. From there I went to Ubuntu, and then there was
no stopping me. I was distro hopping like crazy for
many years, but have finally stopped and settled on
Slackware, PCLinuxOS, and most recently
Opensuse leap (all installed on separate hard drives
that I've collected, as I'm way to lazy to try to figure
out dual booting).

PCLinuxOS Family Member Spotlight is an exclusive,
monthly column by smileeb, featuring PCLinuxOS forum
members. This column will allow “the rest of us” to get to
know our forum family members better, and will give
those featured an opportunity to share their PCLinuxOS
story with the rest of the world.

If you would like to be featured in PCLinuxOS Family
Member Spotlight, please send a private message to
smileeb, parnote or Meemaw in the PCLinuxOS forum
expressing your interest.

PCLinuxOS Family Member Spotlight: jlane01
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By Meemaw

I have signed on to the Gimp Chat forum. It is a fun
place where everyone shows their Gimp creations
and help each other learn new things. A user named
alc59 posted a tutorial for this project. I took a
screenshot of a Google map of Kansas City and
used it for this tutorial. I was surprised how easy it
turned out to be. This is the map I used to start:

Let’s start by giving ourselves more room in the
image. Choose Image > Canvas Size. I want a 50
pixel border around my map, so I added 100 pixels
to each measurement, clicked on Center, then
clicked Resize.

Choose Layer > Layer to Image Size, so when we
start changing things the changes will show up
correctly. Now let’s put some guides in where we
want our map folds. From the left ruler, click and
drag three guides over your map to divide it into
fourths.

Using your rectangle select tool, select the first
section of your map, then click on the Shear tool,
then click back in the selection.

Give the Y magnitude a setting of -50, then click
Shear. Anchor the layer, then select the third section
and do the same thing.

Selecting the second section, apply the value 50
(positive this time). While you have the section
selected, choose Color > Hue and Saturation and

GIMP Tutorial: Make A Folded Map

http://gimpchat.com/index.php
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change the Lightness to about -20 or so, whatever
looks good to you, enough to make it look like it’s a
bit shadowed. Anchor the layer.

Do the same steps with the fourth section.

You can move your guides back now as we no
longer need them. Now we will use the perspective
tool to make our map look more realistic.

Choose the perspective tool and move the top of
your map down and inward so it looks more like it's
lying on a surface.

Choose Layer > Layer to Image size. Duplicate this
layer and move it under the main map layer. Right
click on the layer copy and choose Alpha to
selection, then bucket fill it with black. You might
have to set your Threshold up quite a bit on your
bucket fill tool, but it will work. Also, create a new,
transparent layer and put it under both of your other
layers.

We will put a shadow under this map. Choosing the
black layer, click on your Scale tool and shorten that
layer down so it’s only about ¼ the height of the map
layer.

Choose Layer > Layer to Image size for this layer
as well. For the shadow, we want to choose Blur >
Gaussian Blur and set it about 35. Now it has a
shadow.

Now, choose the bottom, transparent layer and use
the Gradient tool, choosing a Linear BG to FG
gradient. On mine, I changed the foreground color to
blue, but you could make it any color you wish. This
time I’ll use a beige. Start in the upper left with your
gradient so it looks like the light is coming from
there. That’s why we made the sections facing away
from the light a little darker. The result is below.

I had fun with this one! You don’t have to use a map,
either. You can use any picture you desire, or even
make the folds different - horizontal, maybe, or only
two folds. Your only limit is your imagination.

GIMP Tutorial: Make A Folded Map
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Screenshot ShowcaseScreenshot Showcase

International Community
PCLinuxOS Sites

Netherlands

Turkey

Denmark

Czechoslovakia

Italy

Poland

Brazil

Posted by francesco_bat, on April 16, 2016, running KDE.

http://www.pclinuxos.nl/
http://www.bekozap.com/
http://www.pclinuxos.dk/news.php
http://www.pclinuxos.cz/
http://pclinuxos.it/
http://pclinuxos.org.pl/
http://pclinuxos.fi/
http://www.pclinuxosbrasil.com.br/
http://www.opensource.org/
http://www.linuxforum.com
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Ingredients:

Ground Beef

3 lb lean (at least 80%) ground beef
1 cup chopped onions
2 to 3 chipotle chiles in adobo sauce, finely chopped
2 teaspoons adobo sauce (from jar)
1 teaspoon salt
1 teaspoon ground cumin
2 teaspoons chile powder
1/2 teaspoon onion powder
1/2 teaspoon garlic powder
1/4 teaspoon sugar
1 cup water

Tacos

4 frozen dinner roll dough (raw),
thawed as directed on bag

Canola oil for frying

Toppings

Shredded cheese
Chopped tomatoes
Diced onion
Fresh cilantro
Shredded lettuce
Sour cream
Hot sauce

Directions:

1. In slow cooker, stir together Ground Beef
ingredients. Cover; cook on High heat setting 2
hours. Stir mixture to break up beef. Cover; cook 2
hours longer or until beef is no longer pink. With
slotted spoon, remove beef from slow cooker; place
half in bowl and keep warm. Place remaining half in
freezer container or freezer plastic bag; freeze for
another use.

2. With hands or rolling pin, flatten dinner roll dough
into rough rounds about the diameter of a small taco
shell. If sticky, dust with flour.

3. Heat cast-iron or deep skillet over medium-high
heat. Fill with about 1/2 inch of canola oil; heat oil
until hot. Fry dough rounds in batches a few minutes
per side or until dough is deep golden brown. Flip;
repeat. Remove fried bread to plate lined with paper
towels to drain.

4. Top fry bread with beef and
desired toppings. Serve with a knife
and fork, or if you don’t mind a little
mess, just like a regular taco.

The PCLinuxOS
Magazine

Created with
Scribus

PCLinuxOS Recipe Corner

Beef Fry Bread Tacos

http://www.linuxfoundation.org/
http://www.scribus.net
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Editor’s Note: Tip Top Tips is a new monthly column in The PCLinuxOS Magazine. Each
month, we will feature – and possibly even expand upon – one tip from the PCLinuxOS
forum. The magazine will not accept independent tip submissions specifically intended for
inclusion in the Tip Top Tips column. Rather, if you have a tip, share it in the PCLinuxOS
forum’s “Tips & Tricks” section. Your tip just may be selected for publication in The
PCLinuxOS Magazine.

This month’s tip comes from PCLinuxOS forum member chilly.

I needed to update my BIOS to enable my motherboard to accept a faster CPU.
After five hours of trying to update using freedos, Win98 boot image and other
various ways, I gave up and asked for some help from Not_yet_16. He suggested
'flashrom.'

First of all make sure you are up to date. Then, install flashrom from Synaptic.

Check if your hardware is supported by flashrom from this link:
https://www.flashrom.org/Supported_hardware

If your hardware is supported, you can now download and unpack your new
BIOS into a folder. I named the folder 'updatebios.'

While inside the folder in Dolphin, go to 'Tools: Open terminal' and su to root. Run
this command to familiarize yourself with the way flashrom works:

flashrom -h

[root@localhost updatebios]# flashrom -h
flashrom v0.9.8-r1888 on Linux 4.4.4-pclos1 (x86_64)
flashrom is free software, get the source code at
http://www.flashrom.org

Please note that the command line interface for flashrom has
changed between
0.9.5 and 0.9.6 and will change again before flashrom 1.0.

Usage: flashrom [-h|-R|-L|-p <programmername>[:<parameters>] [-c
<chipname>]
[-E|(-r|-w|-v) <file>] [-l <layoutfile> [-i <imagename>]...] [-n]
[-f]]
[-V[V[V]]] [-o <logfile>]

-h | --help print this help text
-R | --version print version (release)
-r | --read <file> read flash and save to <file>
-w | --write <file> write <file> to flash
-v | --verify <file> verify flash against <file>
-E | --erase erase flash memory
-V | --verbose more verbose output
-c | --chip <chipname> probe only for specified flash

chip
-f | --force force specific operations (see

man page)
-n | --noverify don't auto-verify
-l | --layout <layoutfile> read ROM layout from

<layoutfile>
-i | --image <name> only flash image <name> from

flash layout
-o | --output <logfile> log output to <logfile>
-L | --list-supported print supported devices
-p | --programmer <name>[:<param>] specify the programmer device.

One of internal, dummy, nic3com, nicrealtek, gfxnvidia,
drkaiser, satasii,atavia, it8212, ft2232_spi, serprog,
buspirate_spi, dediprog, rayer_spi, pony_spi, nicintel,
nicintel_spi, nicintel_eeprom, ogp_spi, satamv, linux_spi,
usbblaster_spi, pickit2_spi.

Tip Top Tips: Update Your BIOS The Easy Way

http://www.pclinuxos.com/forum/index.php/topic,137026.msg1169044.html#msg1169044
https://www.flashrom.org/Supported_hardware
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You can specify one of -h, -R, -L, -E, -r, -w, -v or no operation.
If no operation is specified, flashrom will only probe for flash
chips.
[root@localhost updatebios]#

Check if flashrom works with your board using this command:

flashrom -p internal

You should see something like this:

[root@localhost updatebios]# flashrom -p internal
flashrom v0.9.8-r1888 on Linux 4.4.4-pclos1 (x86_64)
flashrom is free software, get the source code at
http://www.flashrom.org

Calibrating delay loop... OK.
Found chipset "Intel ICH9R".
Enabling flash write... OK.
Found Macronix flash chip
"MX25L8005/MX25L8006E/MX25L8008E/MX25V8005" (1024 kB, SPI) mapped
at physical address 0x00000000fff00000.
No operations were specified.
[root@localhost updatebios]#

We now need to save the old BIOS file, just in case you get an error writing the
new one. The command I used was this:

flashrom -p internal -r oldbios.170

[root@localhost updatebios]# flashrom -p internal -r oldbios.170
flashrom v0.9.8-r1888 on Linux 4.4.4-pclos1 (x86_64)
flashrom is free software, get the source code at
http://www.flashrom.org

Calibrating delay loop... OK.
Found chipset "Intel ICH9R".
Enabling flash write... OK.
Found Macronix flash chip
"MX25L8005/MX25L8006E/MX25L8008E/MX25V8005" (1024 kB, SPI) mapped
at physical address 0x00000000fff00000.
Reading flash... done.
[root@localhost updatebios]#

You will see the old BIOS has been saved.

Substitute your file names in the command. For example, if your file ends with
BIN, then you need to specify the command for retrieving your old BIOS as
'oldbios.BIN.'

It is now time to write the new bios. I used this command:

flashrom -p internal -w A7345IMS.190

If all goes well, you will see the write as OK and it will be verified. Reboot and set
up your new BIOS.

Please make sure you download the correct BIOS file for your motherboard,
taking note of the version number, because if you use a wrong file to flash your
computer, there is no way back.

If your computer is the latest and greatest, you should be able to flash your BIOS
by just putting the new files on a FAT32 formatted usb stick, and then write to
BIOS from within the BIOS setup.

Tip Top Tips: Update Your BIOS The Easy Way

http://chimpbox.us
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Screenshot ShowcaseScreenshot Showcase

Posted by Hertz, on April 2, 2016, running LXDE.
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Contribute.

Build.

The PCLinuxOS
Knowledge Base

It Belongs To YOU!

Linux Training
Courses & Classes

1. All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2. The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3. The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation. All trademarks are the property of their respective
owners.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.

Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.

Disclaimer

http://pclinuxoshelp.com/index.php/Main_Page
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by daiashi

About The Game

Zombasite is a zombie apocalypse action RPG set in
a dynamic, evolving, fantasy world for Windows,
Mac, and Linux.

Lots of spells and weapons. Gauntlet on steroids.

The dark elves have always played god by creating
and enhancing underworld slave creatures. As they
watched a horde of zombies destroy the huge
demon city Kraval, the dark elves were tantalized by
the devastating power of uncontrolled zombies, and
desired to control and increase it. When they wove
their dominating magic into a few captive zombies,
something went horribly wrong!

They hadn't known the powerful necromancer,
Ciglio, had created these zombies. To control his
huge armies of undead, Ciglio permanently bound
his zombies and their infected victims to him. This
binding was so powerful, their loyalty surpassed his
untimely death. In the dark elves' pride and lust, their
magic twisted into Giglio's binding, fusing into a new,
uncontrollable creation, the Zombasite.

Zombasite is a nasty, voracious, all-consuming
Zombie Parasite. It doesn't just reanimate the dead
into mindless zombies. It is intelligent, insatiable,
and unstoppable—infecting and killing the living,
spreading faster and in more ways, helping the dead
utilize many of their original skills, and mutating the
dead with new powers.

You are the leader of a clan trying to survive the
apocalypse. This is easier said than done. When a
follower dies, they can't be saved by any means.
The Zombasite is highly contagious and zombies are
quickly ravaging the world's surface. Food is a
critical resource that must be obtained. Vendors are
rare and have limited supplies. Some of the stronger
monsters have survived and are as dangerous as
ever. Clans of humans and monsters are fighting
over what few supplies are left. Even within your
own clan it isn't safe.

I played through the demo and had no problems
whatsoever on PcLinuxos. It's nice to see these
games being developed for such a fine OS. I believe
that after Valve started pushing gaming on Linux,
other software companies started to take notice.
Hope you like this hack and slash. I know I did.

System requirements:
Fully updated PCLinuxOS and Steam

Hardware:
Minimum:

OS: PCLinuxOS
Processor: 2 GHz Intel Core 2 Duo
Memory: 512 MB RAM
Graphics: Geforce 2 or better
Hard Drive: 350 MB available space

About The Company

Soldak Entertainment, Inc. is a small independent
developer, focused on bringing new and unique
gameplay to the entertainment industry. Soldak was
founded by Steven Peeler. Before embarking on his
own in late 2004 to create Depths of Peril, Steven
was Technical Director of Ritual Entertainment.

Some Gameplay Screenshots

Game Zone: Zombasite
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Getting It To Run

Install Steam (if you don’t have it installed already),
then start it. You will need to create a new account, if
you do not already have one. Once you have Steam
up and running, go to the store tab. Click on the

Linux tab if you wish and search for. Click on and
download the demo. If you have updated your
system, including graphics drivers, you should be
good to go.

Zombasite

Screenshot ShowcaseScreenshot Showcase

DOWNLOAD

Mate Desktop

Posted by luikki, on April 4, 2016, running KDE.

Game Zone: Zombasite

http://store.steampowered.com/app/455620/
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By Alessandro Ebersol (Agent Smith)

Programs to control collections abound: Tellico,
GCstar, Griffith, Ant Movie Catalog, among others.
But we can also say that there are Ferraris and
Porsches. Why then, Lamborghinis?

The answer is: Each one is excellent, depending on
the customer's taste and for what it is used. Data
Crow is the same thing. It is another collections
manager program, but at the same time, it is
different from the others, with features that set it
apart from the rest.

What is the Data Crow?

The definition, from its site http://www.datacrow.net/:

"Data Crow is the ultimate cataloger and media
organizer. You always wanted to manage all your
collections in one product? You want a product you
can customize to your needs? Your search is over!
Using Data Crow you can catalog all your
collectibles, no matter how big your collection is.
Using the excellent online services you can retrieve
the information about your books, software, games
and movies. This combined with the file import,
where you can analyze information from your e-book
files, software, images, music and movies, saving a
lot of typing."

Data Crow is a software powered by HSQLDB
(Hyper Structured Query Language Database),
which gives it versatility, power and robustness.

Installing Data Crow

Go to http://www.fosshub.com/Data-Crow.html and
choose Download Data Crow Installer (Linux, Mac,
...). You should download the file
datacrow_4_1_0_installer.zip. It is interesting to note
that Data Crow supports eight languages natively.

Unzip the file, and give executable permission to the
installer.sh file (chmod + x filename) to start the
installation of Data Crow.

The installation dialog should appear below.

Click Next (top, right).

Accept the license, which is GPL3, and continue the
installation (center, right).

A donation notice, if you find the program useful, to
reward the programmer.

Choose the installation path. Generally,
/home/user/Data Crow, but it can be changed (next
page, top left).

Choose the installation components, usually the
complete installation is the default (next page, center
left).

Control Your Collections With Data Crow

http://www.datacrow.net/
https://en.wikipedia.org/wiki/HSQLDB
http://www.fosshub.com/Data-Crow.html
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Set the shortcuts’ options, in the programs menu
and also on the Desktop.

If all went well, the final screen is the screen below

By clicking Done, the installation ends.

Now, let's run Data Crow for the first time.

In the programs menu, it must have created an entry
for Data Crow with three items: Data Crow, Data
Data Crow changelog and Data Crow readme. For
some reason, the last two options do not work. But
it's nothing that prevents the program from running.

Now make a small adjustment: go to
/home/user/.local/share/applications/ and look for
two .desktop files, Data Crow- * .desktop and Date
Crow- * .desktop. They have a sequence of numbers
in the name (*) that are created during installation,
and they are different every time you install the
program.

The content of these files will be like this:

[Desktop Entry]
Categories=
Comment=Data Crow
Comment[en]=Data Crow
Encoding=UTF-8
Exec=java -jar "/home/user/Data Crow/datacrow.jar"
GenericName=
GenericName[en]=
Icon=/home/user/Data Crow/icons/datacrow64.png

MimeType=
Name=Data Crow
Name[en]=Data Crow
Path=
ServiceTypes=
SwallowExec=
SwallowTitle=
Terminal=true
TerminalOptions=
Type=Application
URL=
X-KDE-SubstituteUID=false
X-KDE-Username=root

# created by
com.izforge.izpack.util.os.Unix_Shortcut $Revision$
# $Id$

In line marked in bold and red, remove the true, or
else every time the program starts, it will open a
terminal.

Now, when you start the program, a dialog will open:

Specify a folder where the Data Crow data files
should be stored. I usually create a folder named
DC_data, then click OK.

After the choosing the program data folder, it will ask
for the default language (ext page, top left).

Control Your Collections With Data Crow



PCLinuxOS Magazine Page 23

Choose and click OK. The program's operation
screen will show, like this:

The Data Crow Modules

Data Crow comes with a default set of modules
(depending on how you installed Data Crow). Below
you will find a short description on the purpose of
each of these modules. Most of these modules have
powerful online services available to find information
on your items, as well as file importers to retrieve
information from the files stored on your system or
external sources. Each of these modules has
specific reports available. Most modules allow you to
track if an item has been borrowed by a contact
person. In short, each of the default modules has an
extended set of tools available to make your life
easier.

Software Module. The software module can
be used to register both software programs

and games. There are various online services
available to update or find your items online, such as
Amazon and MobyGames.com. Additionally, you can
import the file information of any file. Apart from the
software titles, Data Crow also keeps track of the
developers and the publishers of the software.

Movie Module. Allows you to register both
your DVD/Blu-ray collection and your movie
file collection (DIVX, XVID, etc.). The online

services, such as IMDB.com, are capable of
retrieving detailed movie information, including
detailed information on each actor and director.

Image Module. With the images module,
you can register your image file collection
(JPEG, BMP, GIF, etc.). The image module

does not provide any online services, but can extract
detailed information from your image files using the
file importer.

Container Module. A container is the
physical location of an item. A container can
represent a CD-case, closet, building or

anything else that identifies the location of an item. It
is possible to create a hierarchy of containers, such
as: Building - Floor - Closet - Shelf - Spot on shelf. If
supported by the module, an item can be assigned
to multiple containers. The container module has no
file importers or online services available.

Books Module. The book module can be
used to register your books and your
eBooks (PDF). Amazon, Bol.com and other

online services make it easy to find information on
your books. The file importer can import information
on eBooks. Book publishers and authors are
maintained in separate modules, making it possible
to store detailed information on each of these
persons/companies.

Music Album Module. This module can be
used to register your complete music
collection. This module has online services

available, and can extract information from an

inserted CD (Tools > Retrieve CD information).
Additionally, it has a file importer available for your
file based music albums (MP3, OGG, FLAC, etc.).
The file importer can extract information from MP3s
and other music files. Apart from the music album
itself, this module also manages the music artists.

Media Module. The media module gives
you access to all media items. It shows
items of each of the media modules, such as

software titles, movies and audio CDs. This is a
convenient place to oversee your whole media
collection from one place.

Contact Person Module. This module
allows you to maintain your friends and
family members who can borrow your items.

It does not have any online services or file importers
available.

User Module. This module maintains the
users who can log into Data Crow and their
permissions.

An interesting feature about the program is that it
treats all the items as collections, users, contact
persons or registered items, so that the data can be
connected and referenced easily and quickly.

Where Data Crow stands out from the crowd

Once you have created your database, set operators
and contact people, you can make Data Crow work
in a client-server model. To do so, go to
http://www.fosshub.com/Data-Crow.html, click
Download Data Crow Portable Server Edition
(Headless), and download the file
datacrow_4_1_0_server_zipped.zip.

Then unzip the file, and it will create a dc-server
folder.

Within that folder, open a terminal and type:

Control Your Collections With Data Crow

http://www.fosshub.com/Data-Crow.html
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java -Xmx256m -jar datacrow-server.jar
-userdir:/home/user/DC_data
-webserverport:8080

Note: user is the user where you installed the
regular Data Crow. And DC_data is where the Data
Crow files are located (as you specified in the
installation).

Then, on any computer on the same network, you
can access Data Crow remotely, and manage
collections, via a regular web browser. Just point to
the URL
http://Data_Crow_computer_ip:8080/datacrow

In any browser, the interface will show as the figure
below:

With Data Crow, you can manage a small school
library, a project where I am involved and have been
using it successfully since 2013.

Congratulations and donations to the creator of this
fantastic program, Mr. Robert Jan Wan Der Waals,
http://www.datacrow.net/

I hope you enjoy, and it can solve your issues
related to collections management.

Screenshot ShowcaseScreenshot Showcase

linuxfordummies.org

There Are No Stupid Questions

Posted by Nok, on April 10, 2016, running Mate.

Control Your Collections With Data Crow

http://pclinuxos.com/?page_id=7
http://linuxfordummies.org/
http://data_crow_computer_ip:8080/datacrow
http://www.datacrow.net/
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SCRAPPLER RULES:
1. Follow the rules of Scrabble®. You can
view them here. You have seven (7) letter
tiles with which to make as long of a word
as you possibly can. Words are based on
the English language. Non-English
language words are NOT allowed.
2. Red letters are scored double points.
Green letters are scored triple points.
3. Add up the score of all the letters that
you used. Unused letters are not scored.
For red or green letters, apply the
multiplier when tallying up your score.
Next, apply any additional scoring
multipliers, such as double or triple word
score.
4. An additional 50 points is added for
using all seven (7) of your tiles in a set to
make your word. You will not necessarily
be able to use all seven (7) of the letters in
your set to form a “legal” word.
5. In case you are having difficulty seeing
the point value on the letter tiles, here is a
list of how they are scored:

0 points: 2 blank tiles
1 point: E, A, I, O, N, R, T, L, S, U
2 points: D, G
3 points: B, C, M, P
4 points: F, H, V, W, Y
5 points: K
8 points: J, X
10 points: Q, Z

6. Optionally, a time limit of 60 minutes
should apply to the game, averaging to 12
minutes per letter tile set.
7. Have fun! It's only a game!

SUDOKU RULES: There is only one valid solution to each
Sudoku puzzle. The only way the puzzle can be considered
solved correctly is when all 81 boxes contain numbers and the
other Sudoku rules have been followed.

When you start a game of Sudoku, some blocks will be prefilled
for you. You cannot change these numbers in the course of the
game.

Each column must contain all of the numbers 1 through 9 and
no two numbers in the same column of a Sudoku puzzle can
be the same. Each row must contain all of the numbers 1
through 9 and no two numbers in the same row of a Sudoku
puzzle can be the same.

Each block must contain all of the numbers 1 through 9 and no
two numbers in the same block of a Sudoku puzzle can be the
same. D
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Possible score 206, average score 144.

PCLinuxOS Puzzled Partitions

http://pclosmag.com/html/Issues/201605/files/2016-05-PuzzleSolutions.pdf
http://www.scrabblesite.com/scrabble/rules/
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1. yummy fruit to put in a pie or eat plain

2. easier to water with this than carrying a

bucket

3. outside leisure area

4. most everyone uses this to keep the

grass trimmed

5. good for digging

6. dig these out of the garden

7. spring flower that grows in many colors

8. one of the first spring flowers in many

places

9. beautiful flowers for romance

10. can be planted as a partition between

yards

11. growing your own seasonings

12. rows of fruit trees

13. a separate container for some garden

items

14. used to even out the dirt or gather

vegetation together

15. hook this to your hose

Download Puzzle Solutions Here

PCLinuxOS Puzzled Partitions

PCLinuxOS Crossword Puzzle: May 2016
Gardening

http://pclosmag.com/html/Issues/201605/files/2016-05-PuzzleSolutions.pdf
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bulbs
bushes
daffodils
flowers
flowerbed
fruit trees
garden
grass
green beans
hedges
herb garden
hose
iris
lawn
lawnmower
orchard
patio
peppers
planter
potatoes
rake
roses
shovel
soil
sprinkler
strawberries
tulips
vegetable garden
watermelon
weeds

Download Puzzle Solutions Here

R Q B D L S P J J L U I C E A S R E W O L F D V C L S Z U K
F O J U F Z G D R W T W M D Z L S K G X P G L Y X T W P H U
T K D V S I E D T G P V E A Z G T R Z G G C I E A H V E Q Q
Z U B V C H D A G I Z X S F U A Q J J E A H J D S S E L O O
N S S U N Z E L W R P T O F A B U L B S N M I O P R R A S H
A E U L M R Q S E G D E H O J G S S V E M H V B R V X O S K
F S A K R C O Q C C C K L D M Z G S D V O L O L I O S S G R
S O Z I T Y C R A L I O S I A K J R X O J P D C N S D E E W
F R J Y J X Z Z S U L D R L R D A S P F N K H X K I Y I R C
J V W W E Q W D V U C V Z S C G V A Y J E N Q O L R X R W R
V S E U W V K V B C Z H G T E G O K P U D Q I N E I A R H Z
H L W J D C H T B K T E E L W Z M P G W R T Q R R R W E O S
K T R H P D D O M J B E B M P P H F A E A N Q O Y Z E B K P
W G G E Y P Q X A R O A R J O A Q T W P G P M X Q W O W L F
H Q G T V E M M I Y T D R T A S E O V F B R X I R Y S A J G
K O K Q Y N I X B E X K A J A R M I R G R S A N S Y I R V K
V R H M X H U X G E B T K W M N R U T Y E N H S J L A T N I
F S S A L E P E M K O Z E E W J I D J M H A C O S E M S C S
H H R W E V V E N E R P L A J T Z I P P X E J L V U J J F E
R B E S U X W U S O M O L H T I Q R F X Y B N J A E K U N K
B S P F Y C Q Q P U N T C R A Y M T U C D N F K Z H L F S B
C Y P A I B K J Y R N N E D R A G H A V R E D G Z N J I M V
L J E V P L V P K W V E L Q S W M Y O T A E X M P I R R L J
V R P H K Y P C A C S D E B R E W O L F H R G V N I E C H J
V N A C K E I L G Y Z R K M V A I E I Z C G U Z M T H E R L
E O V W I W T I A D B R N T U L I P S O R Q F N N Q X O G G
M N B I T R L L O I A B I W R W J U J A O H E A Z H H X T O
M Z K C K G E L N D N P L A Y K K Y O A A G L P X U C Y U Y
U R N W Y G O Z O H G W N B P Q Y E B G Z P L M L W A H A C
C G B G A I G T K L V P H R K E S E O J K U B L J E S Q D R

PCLinuxOS Puzzled Partitions

Gardening Word Find

http://pclosmag.com/html/Issues/201605/files/2016-05-PuzzleSolutions.pdf
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Posted by Oneakim, on April 20, 2016, running Xfce. Posted by OnlyHuman, on April 1, 2016, running e20.

Posted by Ximru, on April 19, 2016, running Xfce.Posted by rjmckee, on April 18, 2016, running KDE.

More Screenshot Showcase




